
National Streamflow 
Information 

Program Network 
Analysis



2

Contacts
• Dave Stewart

� 703-648-4879
� dwstewar@usgs.gov

• Jim Kolva
� 703-648-5225
� jrkolva@usgs.gov

• Kernell Ries
� 703-648-5307
� kries@usgs.gov
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Why?
• To define a base network of 

Federally-funded NSIP stations
• To develop a long-term investment 

plan for implementing the NSIP
• To develop legislative support for 

implementing the NSIP plan
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NSIP Network Analysis
• Initially consists of 4 goals to be 

assessed by the district offices 
using the ArcMap GIS tool

• The full analysis consists of 14 
goals, the remaining 10 of which 
will initially be assessed by the 
Office of Surface Water
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Time Frame
• Tools and data for analysis provided to 

districts by August 16, 2000
• Analyses to be completed by the 

districts by September 15, 2000
• OSW will compile data from districts, 

resolve differences, and finalize results 
for the 4 goals by October 15, 2000



Goal 1- Definition
Provide discharge data 
for USGS water-quality 
monitoring networks



Goal 1 - Metric
Operate a discharge 
station at or near each 
Hydrologic Benchmark, 
NASQAN,  and NAWQA 
Low-Intensity Phase station
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Goal 1 – USGS Networks



Goal 2 - Definition
Provide discharge data for 
locations of treaties, 
compacts, and flows 
across State and 
International boundaries



Goal 2 - Metric
Operate a station on the RF1 
reach mandated in all 
compacts and decrees, and 
on all rivers with drainage 
areas greater than 500 sq. mi. 
at State and International 
boundaries 
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Goal 2 Initial Map



Goal 3 - Definition
Provide representative 
discharge data for each of 
the major river basins in 
the Nation



Goal 3 - Metric
Operate 1 or 2 stations that 
provide discharge data for at 
least 50 percent of the 
drainage area of each 
hydrologic accounting unit 
(6-digit HUC)



14

Goal 3 --Hydrologic 
Accounting Units



Goal 4 - Definition
Provide discharge data for 
“Sentinel Watersheds” that 
typify regional natural 
streamflow conditions and 
enable assessments of long-
term trends



Goal 4 - Metric
Operate an unregulated  
station in each area of 100 
sq. mi. or greater formed 
by the intersection of the 6-
digit HUCs and Ecological 
Regions
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Goal 4 – Sentinel Stations
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Gaging Station List
• 20,825 stations in all
• 6,913 active USGS discharge 

stations
• 11,598 discontinued USGS stations
• 1,852 stations operated by other 

agencies 
• 462 non-USGS network stations 

served real-time by USGS
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Active USGS stations
• 1,129 active HCDN stations
• 418 furnished-record stations
• 4,150 USGS real-time stations
• Includes only discharge stations
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Discontinued USGS stations

• 407 inactive HCDN stations
• Includes stage-only stations



21

Other-Agency Stations
• 1,308 discharge stations
• 544 stage stations
• 906 stations with telemetry
• Quality of data is not well 

documented
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Non-Network Real Time

• Includes stations operated by other 
agencies but served on USGS Web 
pages

• Includes USGS project stations not 
considered part of the network
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Determining Active USGS 
Stations
• Queried NWIS database of each district 

to identify stations with discharge daily 
values during 1999 (stage-only sites 
were not included)

• Deleted duplicate station ID’s and 
multiple time series at single locations 

• Deleted “test” and “work” records, etc.
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Determining Active USGS 
Stations, cont’d
• Checked list against 1999 data reports 

to verify active status and identify 
furnished-record stations

• Contacted some districts to resolve 
questions

• Each district should check the station 
list before proceeding further with the 
analysis
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Determining Stations 
Operated by Other Agencies
• Members of the ACWI Streamgaging 

Task Force and USGS district offices 
identified agencies and provided 
contacts

• Agencies provided lists of stations not 
operated by USGS or served through 
USGS Web pages
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Determining Non-Network 
Real-Time Stations
• The active station list was merged 

with a list of all stations served by 
USGS on the Web

• All stations common to both lists 
were removed 
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Station Selection Priorities
1. Active HCDN
2. Active non-HCDN
3. Active furnished-record
4. Recently discontinued HCDN
5. Recently discontinued non-HCDN
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Station Selection Priorities, cont’d

6. Non-network real time
7. Other agency discharge 
8. Other agency stage
9. Long discontinued HCDN
10.Long discontinued non-HCDN
11.New station



Using the ArcMap 
Tool
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First Steps
• Install ArcInfo 8.0.2 with ArcMap on 

an NT workstation
• Insert the NSIP CD into your CD 

drive
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Copy Files to a New Directory 
on Your Hard Disk
• goal_1.mxd
• goal_2.mxd
• goal_3.mxd
• goal_4.mxd
• nsip_sites.ldb
• nsip_sites.mdb
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In NT Explorer

1. Click on the new directory you created 
in the folders frame

2. Click anywhere in the contents frame
3. From the Edit pull-down menu, click 

on Select All to highlight the files
4. With your cursor over any of the 

highlighted files, click your right mouse 
button
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In NT Explorer, cont’d

5. Select Properties from the menu that 
appears by clicking on it with your left 
mouse button

6. Left click on the check box beside 
Read Only to turn it off, click on Apply, 
then on OK
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Starting ArcMap

• Click on the Start button at the bottom 
left of your screen

• Select Programs, then ArcInfo, then 
ArcMap

• Initially, the screen will be split into a 
small Layers frame on the left and a 
large Map frame on the right
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Layers 
Frame

Map Frame

Pull-Down Menus

Tools Toolbar – Move 
to gray area above 
Map Frame by 
clicking on top blue 
band, holding, and 
moving into gray area
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Starting ArcMap, cont’d
• A Tools toolbar will be shown in the 

Map frame. You can move it to the gray 
area above the Map frame by grabbing 
the blue band at the top of the Tools 
box (hold down left mouse button) and 
moving it up out of the Map frame

• Holding your cursor over the items in 
the bar causes their definitions to be 
shown
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The Tools Toolbar

Zoom In – Changes the mapped 
area to a smaller area defined by 
holding the left mouse button down 
and moving the cursor to define a 
rectangle
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The Tools Toolbar, cont’d

Zoom Out – Changes the mapped 
area to a larger area defined by 
holding the left mouse button down 
and moving the cursor to define a 
rectangle
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The Tools Toolbar, cont’d

Fixed Zoom In – Changes the 
mapped area to a smaller area 
defined by software-defined fixed 
amount
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The Tools Toolbar, cont’d

Fixed Zoom Out – Changes the 
mapped area to a larger area 
defined by software-defined fixed 
amount



41

The Tools Toolbar, cont’d

Pan – Changes the center of the 
mapped area by clicking and 
holding on a location on the map 
and moving your mouse
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The Tools Toolbar, cont’d

Full Extent – Shows the entire 
mapped area in the map frame 
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The Tools Toolbar, cont’d

Go Back – Returns to the previous 
view 
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The Tools Toolbar, cont’d

Go Forward – Goes to the next view 
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The Tools Toolbar, cont’d

Select Feature – Selects a feature on 
the map for further analysis
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The Tools Toolbar, cont’d

Select Graphics – Lets you select 
graphics for editing, such as north 
arrows and scale bars
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The Tools Toolbar, cont’d

Identify Features – Provides tables of 
attributes for the features you 
select
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The Tools Toolbar, cont’d

Find Features – Finds geographic 
features based on the attributes 
you select
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The Tools Toolbar, cont’d

Measure Tool – Measures distances 
on the map
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The Tools Toolbar, cont’d

Hyperlink Tool – Triggers a hyperlink 
to a file or URL
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The Editor Toolbar

Editor Button – Activates a pull-down 
menu that allows you to start, stop, 
and save edits, as well as other 
actions that you likely will not use
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The Editor Toolbar, cont’d

Editor Tool – Allows you to select 
features for editing
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The Editor Toolbar, cont’d

Sketch Tool – Allows you to add 
points, lines, and polygons. You will 
use this feature to add new stations 
to the database when existing 
stations do not satisfy network 
goals.
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The Editor Toolbar, cont’d

Task Control – Sets the current 
editing task to be performed
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The Editor Toolbar, cont’d

Target Layer Control – Specifies the 
data layer in which to store new 
features
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The Editor Toolbar, cont’d

Split Tool – Divides one selected 
feature into two; not likely to be 
needed.
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The Editor Toolbar, cont’d

Rotate Tool – Rotates features by a 
user-defined angle; not likely to be 
needed.
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The Editor Toolbar, cont’d

Shared Edit Tool – Selects a 
common point or edge shared by 
two features for editing; not likely to 
be needed.
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The Editor Toolbar, cont’d

Attributes – Allows you to display and 
edit feature attributes
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The Editor Toolbar, cont’d

Unless you need to add a new 
station, you will need to use only 
the Editor Button (A) to start, stop, 
and save edits, the Editor Tool (B) 
to select features, and the 
Attributes Button (C) to edit 
features

A B C
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TIP!
Left-click on the What’s This button and 

then left-click on any other button or 
menu item to see a more detailed 
description of its purpose
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Select a Goal
• Open a goal in ArcMap by clicking 

on Open from the File menu
• Select the goal (ex. goal_1.mxd) 

from the appropriate directory on 
your hard drive, then click on Open
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Define Data Sources
1. The Layers frame on the left of your 

screen shows the data layer names 
and symbols used in the analysis

2. A red exclamation mark will be shown 
initially beside the check box to the left 
of each data layer name

3. Click on the exclamation mark on the 
Active HCDN line to make the Data 
Source window appear
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Define Data Sources, cont’d

4. Select the nsip_sites.mdb file you 
saved on your hard drive

5. Select the all_sites_g_point file that 
appears next in the window

6. The exclamation points will disappear 
from the Layers frame for the first 7 
data layers
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Define Data Sources, cont’d

7. Double-click on the exclamation point 
on the RF1 Streams layer to make the 
Data Source window appear

8. Select the rf1_str.shp file your CD 
drive

9. The remaining exclamation points will 
disappear and a map will be drawn in 
the Map frame
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Goal 1 – Water Quality 
Networks
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Goal 1 – USGS Networks

• NASQAN  -- Redesigned Sites

• HBM – Hydrologic Bench Mark

• NAWQA-LIP – Low Intensity Phase
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Goal 1 – USGS Networks
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Goal 1 --USGS Networks
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Goal 1 – Initial State Map 
Example
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Goal 1 -- Task
• Verify Water Quality network sites have 

an associated streamgage.
• Using goal_1.mxd from your hard drive
• If water-quality network stations in your 

District are correct, nothing else is 
required.

• If incorrect please email 
jrkolva@usgs.gov with corrections.



Goal 2 Analysis
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Goal 2 Setup
1. Open goal_2.mxd from your hard 

disk
2. Follow steps 1 through 9 of Define 

Data Sources
3. Zoom in to your State
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Goal 2 Initial Map
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Goal 2 Example State Map
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Goal 2 Tasks
1. Associate gaging stations to 

stream reaches that cross state or 
international borders and have 
drainage areas greater than 500 
sq. mi. 

2. Associate gaging stations to 
locations of compacts and/or 
decrees
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Border Crossing Process

• Reaches with drainage areas greater 
than 500 sq. mi and adjacent reaches 
are shown in thick blue lines

• “Contender” stations initially identified 
as best representing discharges from 
these reaches are shown with an 
orange cross in a black circle
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Border Crossing Process, cont’d
1. Zoom in to the thick blue reaches
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Border Crossing Process, cont’d

2. Determine if a contender station has 
been selected for the reach in 
question

3. If there is a contender station, 
determine if the selection is correct by 
using the identify tool to examine the 
attributes of all other nearby stations 
and reaches



80

Border Crossing Process, cont’d

4. Click Editor in the Editor toolbar, then 
click Start Editing

5. When the Start Editing window 
appears, select the nsip_sites.mdb file 
that you saved
on your hard 
drive
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Border Crossing Process, cont’d

6. If the contender station is correct:
a. Click on the Edit button in the Editor 

Toolbar
b. Click on the contender site, making it turn 

blue
c. Click on the Attributes button in the Editor 

Toolbar to make the Attributes table 
appear
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Border Crossing Process, cont’d
d. Click in the Value field to the right of the 

BORDER_STATUS attribute and change 
the Value from 0 to 1
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Border Crossing Process, cont’d

e. Set the BORDER attribute to 1 if it is not 
already set

f. Click on the X in the top right corner of 
the Attribute table window to close it

g. The orange cross on the map will turn red
h. Click on the Editor button in the Editor 

Toolbar again
i. Click on Save Edits
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Border Crossing Process, cont’d

7. If the contender station is incorrect:
a. Follow steps 6 a. to 6 g., except select 

the station you feel is most appropriate 
and change its BORDER attribute to 1 
and BORDER_STATUS attribute to 2

b. Select the original contender station, then 
change its BORDER and 
BORDER_STATUS attributes to 0
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Border Crossing Process, cont’d

8. If no contender station was selected, 
either

a. Select the station you feel is most 
appropriate and change its BORDER 
attribute to 1 and BORDER_STATUS 
attribute to 2, as in 7 a., OR

b. Click on the Create New Feature button 
in the Editor toolbar
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Border Crossing Process, cont’d
c. Click on a location along the 

highlighted reach to mark the map 
location with a blue circle

d. Click on the Attributes button in the 
Editor Toolbar to make the 
Attributes table appear

e. Set the BORDER_STATUS to 1 and 
BORDER attribute to 2, and add any 
other attributes for the new station
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TIP!
To select from among more than one 

station at the same location:
1. Determine the station type by its symbol or 

by using the Identify tool
2. Click on the Selection pull-down menu, then 

on Set Selectable Layers
3. Turn off all but the station type that you 

want to select
4. Turn all the types back on when you are 

done



TIP!
Sometimes more than one station 

needs to be selected to 
document flows across state 
borders; for instance, when there 
is no station on the reach that 
crosses the border but there are 
stations on the main-stem reach 
above it and on a major tributary 
that also enters the border reach
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Rivers That Form Borders
• Reaches along rivers that form state or 

international borders are not highlighted 
in thick blue

• USGS stations near border crossings 
where rivers flow from one state to 
another have been selected as 
contenders
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Example Map With Red Arrows 
Indicating Contender Stations Along 
the Mississippi and Pearl Rivers
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Rivers That Form Borders, 
cont’d

• These stations should be reviewed to 
confirm that they are the best candidate 
stations to quantify flows across the 
state boundaries

• Additional existing stations or new 
stations should be added where 
appropriate
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Compacts Process

• Compact locations are indicated on the 
map by yellow stars

• One or more active or inactive USGS 
stations are always associated with the 
location of a yellow star
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Compacts Process, cont’d
1. Click the Edit button in the Editor 

toolbar
2. Click on a Compact location, causing a 

blue circle to appear
3. Click on Attributes in the Editor toolbar
4. Set the COMPACT_STATUS and 

COMPACT attribute values to 1 in the 
attribute table
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Compacts Process, cont’d

5. Specify a station number in the 
COMPACT_SITE_ID attribute value if 
a different station provides information 
for the compact location

6. Close the attribute window
7. The star will turn from yellow to blue
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Compacts Process, cont’d

8. Click on the Editor button in the Editor 
Toolbar

9. Click on Save Edits
10.When all Compact stations have been 

edited, click on the File pull-down 
menu, then on Save to save your file 
to your hard disk
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Goal 3 --Hydrologic 
Accounting Units
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Goal 3 -- Task

• Determine station that is the Most 
Valuable Point (MVP) for each 
Hydrologic Accounting Unit
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Goal 3 --Hydrologic 
Accounting Units MVPs
• Criteria – The station (or stations) 

needed to best determine the flow out of 
the Accounting Unit. 

� For closed basins, the most representative flow 
in the Accounting Unit.
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Goal 3 --Hydrologic 
Accounting Units -- Criteria
• Main stem – The main stem station nearest 

the Accounting Unit pore point. May be 
downstream in the next Accounting Unit.

• Headwaters – The station or stations with the 
largest drainage area(s) in the Accounting 
Unit. May also be downstream in the next 
Accounting Unit.

• Coastal or Closed Basin – The station or 
stations with the largest drainage areas in the 
Accounting Unit.
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Goal 3 – Main Stem 
Accounting Units
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Goal 3 – Headwater 
Accounting Units
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Goal 3 – Coastal or Closed 
Basin Accounting Units
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Goal 3 --ArcMap Attributes

• HUC6_MVPSITE_A

• MVP_HUC6A

• HUC6_MVPSTATUSA

• HUC6_MVPSITE_B

• MVP_HUC6B

• HUC6_MVPSTATUSB
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Goal 3 -- ArcMap Attributes 

• HUC6_MVPSITE_A – Station that best 
meets criteria.  Indicate with a 1 in 
attributes table.

• HUC6_MVPSITE_B – Supplemental 
station needed in that Accounting unit to 
meet criteria.  Also indicated with a 1 in 
attributes table.
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Goal 3 -- ArcMap Attributes  
(continued)
• MVP_HUC6A – Station is the MVP 

point for an Accounting Unit but not 
located in that Accounting Unit.  Enter 
the HUC6 number of the Accounting 
unit represented.
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Goal 3 -- ArcMap Attributes 
(continued)
• HUC6_MVPSTATUSA (or B) – Status 

indicator of the site.
• 0 – Not a MVP SITE or not yet 

reviewed
• 1 – Reviewed, accepted station.
• 2 – New site, rejected first cut 

selection and replaced with this station.



107

Goal 4 – Sentinel Stations
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Goal 4 -- Task

• Determine the best “Sentinel Station” for 
an eco-huc. The station best for 
determining long term trends in flow for 
that particular area. Station should have 
80-90% of its drainage area within the 
eco-huc it represents.
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Goal 4 – Sentinel Stations 
State Example Map
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Goal 4 – Sentinel Stations 
Polygon examples
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Goal 4 – Sentinel Stations

• Criteria – Best represents flow 
conditions from the “eco-huc”.

• Longest period of record at active or 
HCDN station was chosen.   May not be 
representative.
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Goal 4 – Sentinel Stations

• Eco-huc – Intersection of Hydrologic 
Accounting Units and EPA Ecological 
Regions (76 in lower 48 states).



113

Goal 4 – Sentinel Stations
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Goal 4 – Sentinel Stations

• Station should have at least 80-90% of the 
drainage area in the “eco-huc” it represents.

• Station should have the longest period of 
record possible. (Active stations preferred.)

• Every “eco-huc” over 100 square miles 
should have a Sentinel Station.
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Goal 4 – Sentinel Stations
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Goal 4 – ArcMap Attributes

• SENTINEL_SITE

• SENTINEL_STATUS
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Goal 4 – ArcMap Attributes

• SENTINEL_SITE
•
• 0 – Not a Sentinel Site

• 1 – Is a Sentinel Site
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Goal 4 – ArcMap Attributes
• SENTINEL_STATUS

• 0 – Not a Sentinel Site or Not reviewed.
• 1 – Reviewed Sentinel Site; accepted first 

cut.
• 2 – Added Sentinel Site; either replacing 

first cut site or adding to an eco-huc that had 
no contender site.
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When The Analyses Are 
Complete
• Save the 7 files on your hard disk that 

you copied from the CD
• Zip the files together
• Email them to Dave Stewart at 

dwstewar@usgs.gov



THANKS!


